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RS-Bpearl User Manual
Congratulations on your purchase of a RS-Bpearl Real-Time 3D LiDAR Sensor. Please
read carefully before operating the product. Wish you have a pleasurable product
experience with RS-Bpearl.

1. Safety Notice
In order to reduce the risk of electric shock and to avoid violating the warranty, do not
open sensor housing.


Laser safety - The laser safety complies with IEC60825-1:2014.



Read Instructions - All safety and operating instructions should be read before
operating the product.



Follow the Instructions - All operating and use instructions should be followed.



Retain Instructions - The safety and operating instructions should be retained for
future reference.



Heed Warnings - All warnings on the product and in the operating instructions should
be adhered to.



Maintenance - The user should not attempt to maintain the product beyond what is
described in the operating instructions. All other Maintenance should be referred to
RoboSense.
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2. Introduction
RS-Bpearl, the close-range LiDAR developed by RoboSense, is the world leading LiDAR
for monitoring blind spot. It is particular utilized in and perception of environment for
autonomous driving.
RS-Bpearl is realized by solid-state hybrid LiDAR. The technical details are listed below:
 Minimum measuring range: 10 cm
 Accuracy: within up to ± 2 centimeter
 Data rate up to 576,000 points/second
 Horizontal field of view (FOV) of 360°
 Vertical field of view (FOV) of 90°

Figure 1:Representation of RS-Bpearl Imaging.

The operating Instructions of LiDAR:
 Connecting the device of RS-Bpearl;
 Parsing the data packets, in order to capturing the values of azimuth, measuring
distance and calibrated reflectivity;
 Calculate X, Y, Z coordinates from reported azimuth, measured distance, and vertical
angle;
 Storing the data of point cloud according to demand;
 Checking the status of set-up information of device;
 Resetting the status of network configuration, timing and rotation speed according to
demand.
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3. Product Specifications1

Sensor

Laser

Output

Mechanical/
Electrical/
Operational









Table 1: Product Parameters.
TOF measuring distance, including the reflectivity
Range: from 0.1 m to 30m (Reflectivity: 10%)2
Accuracy: ±3cm (typical value)3
FOV(vertical): 90°
FOV (horizontal): 360°
Angle resolution (horizontal/ azimuth): 0.2° (10 Hz)/0.4° (20 Hz)
Rotation speed: 600/1200 rpm (corresponding to 10/20 Hz)





Class 1






Date rate: ~600k points/second









Power consumption: 13 W(typical)4

Wave length: 905nm
Full angle of beam divergence: horizontal 9 mrad, vertical 17.8 mrad
100M Ethernet
Communication protocol: UDP
The Information that is included in Dates Segment:
Distance
Rotation angle/Azimuth Calibrated
reflectivity
Synchronized timestamp (Timer resolution 1 us)

Working voltage: 9-32 VDC
Weight: 0.92 kg (without cable)
Dimensions: Diameter 100 mm × Height 111 mm
Ingress Protection Rating: IP67
Operation temperature: -30 ℃~+60 ℃5
Storage temperature: -40 ℃~+85 ℃

The following data is only for mass-produced products. Any sample, testing machine and other
non-mass-produced versions may not be referred to this specification. If you have any questions, please
contact RoboSense sales.
2
The measurement target of range is a 10% NIST Diffuse Reflectance Calibration Targets, the test
performance is depending on circumstance factors, not only temperature, range and reflectivity but also
including other uncontrollable factors.
3
The measurement target of accuracy is a 50% NIST Diffuse Reflectance Calibration Targets, the test
performance is depending on circumstance factors, not only temperature, range and reflectivity but also
including other uncontrollable factors.
4
The test performance of power consumption is depending on circumstance factors, not only
temperature, range and reflectivity but also including other uncontrollable factors.
5
Device operating temperature is depending on circumstance, including but not limited to ambient
lighting, air flow and pressure etc.
1
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4. Interface
4.1 Power Supply
A voltage transform module is already integrated in RS-Bpearl. The supply voltage could
keep in the range of 9~32 VDC with utilization of Interface-Box. The recommend supply
voltage is 12 VDC. The operating power consumption is about 13 W (typical).

4.2 Data Output interface of LiDAR
The data output access of RS-Bpearl is physically protected by an aviation terminal
connector. From the LiDAR to the aviation connector the cable length is 1 meter. The pins
of the aviation terminal connector are defined as follow:

PIN

Wire Color

Function

1

Red

+12V

2

Yellow

+12V

3

White

GROUND

4

Black

GROUND

5

Green

GPS PULSE

6

Blue

GPS REC

7

Brown

LiDAR Ethernet RX+

8

Brown white

LiDAR Ethernet RX-

9

Orange

LiDAR Ethernet TX+

Orange white

LiDAR Ethernet TX-

10

Figure 2: Aviation Connector PIN Number.

4.3 Interface Box
In order to connect the RS-Bpearl conveniently, there is an interface box provided.
There are accesses for power supply, Ethernet and GPS on Interface Box. Meanwhile
there are also indicator LEDs for checking the status of power supply.
For those accesses, an SH1.0-6P female connector is the interface for GPS signal input.
Another interface is a DC 5.5~2.1 connector for power input. The last one is a Rj45
Ethernet connector for RS-Bpearl data transport. The length of the integral cable is 3 m,
when the cable length needs to be shorten or extended, please contact RoboSense
technical support, as shown in Figure 3.
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PIN

Function

1

GPS PULSE

2

+5V

3

GND

4

GPS REC

5

GND

6
NC
Figure 3: Interface Definition Interface Box.
Note: When RS-Bpearl connects its grounding system with an external system, the
external power supply system should share the same grounding system with that of the
GPS.

When the power input is in order, the red LED which indicates the power input status will
be lighted. Meanwhile the green LED which indicates the power output status will be
lighted, when the power output is in order. While red LED is bright and green LED is dark,
Interface Box is in Protection status. While red and green LEDs are all dark, please check
whether the power supply is out of order or damaged. If it is intact, that could prove that
the Interface Box is damaged. Please send the damaged Interface Box back to
RoboSense Service.
GPS interface definition: GPS REC stands for GPS input; GPS PULSE stands for GPS
PPS input.
Interface of power supply is standard DC 5.5-2.1 connector.
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4.4 Connection of Interface Box

Figure 4: Diagram of Interface Box Connection.
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5. Communication Protocol
RS-Bpearl adopts IP/UDP protocol and communicates with computer through Ethernet. In
this User Guide, The UDP protocol packet in this manual is of 1290 byte long and consists
of a 1248-byte valid payload and a 42-byte header. The IP address and port number of
RS-Bpearl is set in the factory as shown in the Table 2, but can be changed by the user as
needed.
Table 2: The IP Address and Port Number Set in the Factory.

Device

IP Address

RS-Bpearl

192.168.1.200

PC

192.168.1.102

MSOP Port No.

DIFOP Port No.

6699

7788

The default MAC Address of each RS-Bpearl is already set up in the factory with
uniqueness. In order to establishing the communication between a RS-Bpearl and a
computer, the IP Address of the computer should be set at the same network segment.
For instance, IP Address is 192.168.1.X (X can be taken by a value from 1~254), subnet
mask: 255.255.255.0. If the internet setting of the sensor is unknown, please set the
subnet mask as 0.0.0.0, connect the sensor to the computer, and capture UDP packet to
get the information of IP and Port through Wireshark.
RS-Bpearl adopts 3 kinds of communication protocols to establish communication with the
computer:
 MSOP (Main Data Stream Output Protocol). Distance, azimuth and reflectivity
data collected by the sensor are packed and output to computer;
 DIFOP (Device Information Output Protocol). Monitor the current
configuration information of the sensor;
 UCWP (User Configuration Write Protocol). User can modify some
parameters of the sensor as needed.
Table 3: Overview of the MSOP.

Protocol

Abbreviation

Function

Type

Size

Interval

Main data Stream Output Protocol

MSOP

Scan Data Output

UDP

1248 bytes

~0.66 ms

Device Information Output Protocol

DIFOP

Device Information Output

UDP

1248 bytes

~100 ms

UCWP
Sensor Parameters Setting UDP 1248 bytes
User Configuration Write Protocol
Note: In the following chapters only the valid payload (1248 byte) will be discussed.

5.1 MSOP
MSOP is the abbreviation of Main Data Stream Output Protocol. I/O type: device output
data, computer parse data.
Default port number is 6699.
MSOP outputs data information of the 3D environment in packets. Each MSOP packet is
1248 bytes long and consists of reported distance, calibrated reflectivity values, azimuth
values and a timestamp.
In each RS-Bpearl MSOP packet, payload is 1248-byte long and consists of a 42-byte
header and a 1200-byte data field containing twelve blocks of 100-byte data records and a
6-byte tail. The basic data structure of a MSOP packet for single return is as shown in
Figure 5：

7
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Figure 5: Single Return MSOP.
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The basic data structure of a MSOP packet for dual return is as shown in
Figure 6.

First
return

Second
return

Figure 6: Dual Return MSOP.

5.1.1 Header
The 42-byte Header marks the beginning of data blocks.
In the 42-byte data header, the first 8 bytes are for header identification, the 21st to 30th byte
records timestamp, and the rest bytes are reserved for future updates.
The first 8 bytes of the header is defined as 0x55, 0xAA, 0x05, 0x0A, 0x5A, 0xA5, 0x50, 0xA0.
Time stamp with a resolution of 1us records the system time. Please refer to the definition of
time in Appendix B.9 and Table 6 in section 5.3 of this chapter.
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5.1.2 Data Field
Data field comprises data blocks that contain valid measurement data, in total 1200 bytes.
Each data filed contains 12 blocks, each block is 100-byte long and is a complete
measurement data set. Each data block begins with a 2-byte start identifier “0xffee”, then
a two-byte azimuth value (rotational angle). Each azimuth value records 32 sets of
channel data reported by the 32 laser channels. (Please see chapter 9 for the relationship
between channel sequence and vertical angel)
5.1.2.1 Azimuth Value

The reported azimuth is associated with the first laser firing in each sequence of laser
firings. The Azimuth Value is recorded by the encoder. The zero position on the encoder
indicates the zero degree of azimuth value on RS-Bpearl. The resolution of Azimuth is
0.01°.
For example, in Figure 8, the azimuth value is calculated through the following steps:
Get azimuth values: 0x61, 0x86
Combine to a 16 bit, unsigned integer: 0x6186 Convert to decimal: 24966
Divided by 100
Result: 249.66°
Hence, the firing angle is 249.66°
5.1.2.2 Channel Data

Channel Data contains 3 bytes, with the upper 2 bytes (16 bits in total) store distance
information, and the lower 1 byte contains reflectivity data. The structure of channel data
is as shown in Table 4.
Table 4： Channel Data Definition.

Channel data n (3 byte)
2-byte Distance
Distance1 [15:8]

1-byte Reflectivity

Distance2 [7:0]

Reflectivity Information

The 2-byte distance data is set in centimeter. The distance resolution is 0.5 cm. The
following shows how to parse channel data：
For example, in the case of Figure 8, the distance information is calculated by:
Get distance values: 0x01, 0xb4.
0x01 is the upper byte of distance, concert to decimal: 1.
0xb4 is the lower byte of distance, convert todecimal: 180.
Hence, distance= upper byte of distance * 256 + lower byte of distance
= 1*256 + 180 = 436.

According to distance resolution, the distance: 435 * 0.05 = 2.18 m.
Hence, the measured distance is 2.18 m.
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5.1.3 Tail
The tail is 6 bytes long, with 4 bytes unused and reserved for other information, and the
other 2 bytes as: 0x00, 0xFF.

5.1.4 MSOP Data Package
The following Figure 8 shows the format of MSOP data packet and relevant parsing
processes.

Figure 7: MSOP Packet.
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Figure 8: Details of MSOP Packet.

5.2 DIFOP
DIFOP is abbreviation of Device Info Output Protocol. I/O type：device output, computer
read.
Default port number is 7788.
DIFOP is a protocol that reports and outputs only device information including the device
serial number, firmware version, driver compatibility, internet setting, calibration data,
electrical machine setting and operation status, fault detection information to users. It is a
viewer for users to get comprehensive details about the device.
Each DIFOP packet is 1248 bytes long, and comprises an 8-byte Header, a 1238-byte
data field, and a 2-byte tail.
The structure of DIFOP is as shown in Table 5.

12
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Table 5: DIFOP Packet Definition.

Segment

No.

Information

Offset

Length/byte

Header

0

DIFOP header

0

8

1

Motor rotation speed (MOT_SPD)

8

2

2

Ethernet (ETH)

10

22

3

FOV setting

32

4

4

Reserved

36

2

5

Motor phase lock (MOT_PHASE)

38

2

6

Top board firmware version (TOP_FRM)

40

5

45

5

7

Data

Tail

Bottom board firmware version
(BOT_FRM)

8

Reserved

50

242

9

Serial number (SN)

292

6

10

Zero angle offset

298

2

11

Return mode

300

1

12

Upper computer compatibility

301

2

13

UTC time (UTC_TIME)

303

10

14

Operation status (STATUS)

313

18

15

Reserved

331

11

16

Fault diagnosis (FALT_DIGS)

342

40

17

GPRMC

382

86

18

Corrected vertical angle

468

96

19

Corrected horizontal angle

564

96

20

Reserved

660

586

21

Tail

1246

2

Note: The Header (the DIFOP identifier) in the table above is 0xA5, 0xFF, 0x00, 0x5A,
0x11, 0x11, 0x55, 0x55, among which the first 4 byte 0xA5, 0xFF, 0x00, 0x5A is the
sequence to identify the packet.
The tail is 0x0F, 0xF0.
For definition of information registers as well as their usage, please check more details in
Appendix B of this manual.

5.3 UCWP
I/O type: computer writes into the device.
Function: user can reconfigure Ethernet connection, time and some parameters of the
device.
Each UCWP Packet is 1248 bytes long, and is comprised of a 8-byte Header and a
40-byte data field.
The UCWP packet structure is as shown in Table 6 below:
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Table 6: UCWP Packet Definition.
Information
Offset

Segment

No.

Length/byte

Header

0

UCWP header

0

8

Data

1

Motor rotation speed

8

2

2

Ethernet

10

22

3

FOV setting

32

4

4

Time

36

10

5

Motor phase lock

46

2

Note: The Header (UCWP identifier) in the table above is 0xAA, 0x00, 0xFF, 0x11,
0x22, 0x22, 0xAA, 0xAA, among which, the first 4 bytes 0xAA, 0x00, 0xFF, 0x11
forms the sequence to identify the packet.
Statement: RS-Bpearl doesn’t RTC system to support operation while power is off. In the
case of no GPS or GPS signal, it is imperative to write time into the device through a
computer, or it will use a default system time for clock.
Refer to Part 2, Section 10 of this manual for details on Ethernet, Time, Motor Rotation
Speed and Motor Phase Lock.
Table 7: An Example for corresponding value of Setting.
Information
Content
Setting
Length/byte
0xAA,0x00,0xFF,
0x11,0x22,0x22,

Header

8

0xAA,0xAA
Rotate Speed
LiDAR IP
(LIDAR_IP)

0x02

600rpm

0x58
0xC0
0xA8

192.168.1.105

0x01

2

4

0x69
Destination PC IP
(DEST_PC_IP)

0xC0
0xA8

192.168.1.225

0x01

4

0xE1
Device MAC Address
(MAC_ADDR)

0x00,0x1C,0x23,

001C23174ACC

0x17,0x4A,0xCC

6

MSOP Port(port1)

6688

0x1A20

2

MSOP Port(port2)

6688

0x1A20

2

DIFOP Port(port3)

8899

0x22C3

2

DIFOP Port(port4)

8899

0x22C3

2

FOV start angle

0

0x0000

2

FOV end angle

12000

0x2EE0

2
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UTC_TIME

Year:2017
Month:3
Day:10
Hour:9
Minute:45
Second:30
Millisecond: 100

0x11
0x03
0x0A
0x09

10

0x2D

Microsecond: 200

0x1E
0x00,0x64
0x00,0xC8

Motor Phase Lock
90
0x005A
2
While setting the device and computer according to this protocol, it is imperative to set all
the information listed in the table above. Addressing or writing in with part of the
information will lead to invalid setting. The function refreshes the moment the
correspondent parameter is changed, but the network parameters only take effect when
the next initialization of device is started.
RSVIEW provides the configuration UI, so we suggest to use RSVIEW to configure the
RS-Bpearl. When performing the parameter writing process, please keep the power
connection for LiDAR and make sure the parameter writing is done when we want to
power off the LiDAR, otherwise there is a risk of parameter configuring error.
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6. GPS Synchronization
RS-Bpearl supports external GPS receiver connections. With GPS connections, we can
synchronize the RS-Bpearl system time and pack the GPRMC message into DIFOP
packets.

6.1 GPS Synchronization Theory
The GPS receiver keeps generating synchronization Pulse Per Second (PPS) signal and
GPRMC message and send them to the sensor. The pulse width of the PPS should
between 20 ms to 200 ms, and the GPRMC message should be received within 500 ms
after the PPS signal is generated.

6.2 GPS Usage
There is only one level protocol for RS-Bpearl GPS_REC pins: RS232 level standard
The GPS interface on the Interface BOX is SH1.0-6P female connector, the pin
definition is as shown in Figure 3.
RS232 pin definition:
Pin GPS REC receives the data that is R232 level standard from the GPS module serial
port;
Pin GPS PULSE receives the PPS from GPS module, and the level requirement is
3.0V~15.0V;
If the GPS output you are using is RS232 serial protocol while the level of the LiDAR
receiver is TTL, then you need to purchase a module which converts RS232 level to TTL
level. For one example, the wiring diagram and definition are as follows:
Pin +5V can supply the power for GPS module. (Please do not connect the GPS into the
+5V pin if the GPS is 3.3V power supply. Also please do not input the power into the +5V
pin because the pin is an output.)
Pin GND provide the ground connection for GPS module.
The GPS module should set to 9600bps baud rate, 8-bit data bit, no parity and 1 stop bit.
RS-Bpearl only read the GPRMC message from GPS module., the GPSMRC message
format is shown as below:
$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh
<1> UTC time
<2> validity - A-ok, V-invalid
<3> Latitude
<4> North/South
<5> Longitude
<6> East/West
<7> Ground Speed
<8> True course<9> UTC date
<10> Variation
<11> East/West
<12> Mode (A/D/E/N=)
*hh checksum from $ to *
Different GPS module may send out different length GPRMC message, the RS-Bpearl
reserve 86byte space for GPRMC message, so it can be compatible with the majority
GPS module in the market.
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7. Key Characteristic
7.1 Return Mode
7.1.1 Return Mode Principle
RS-Bpearl supports multiple return modes: Strongest return, Last return, and Dual return
modes. When set to dual return mode, the details of the target will be enhanced, and the
number of point is twice than that of a single return.
Due to the divergence of the beam, it is possible to generate multiple laser returns with
one laser emission. When the laser pulse is emitted, its light spot gradually becomes
larger. Suppose a light spot is large enough to shot multiple targets and produce multiple
returns. Generally, the farther away the target is, the weaker it will be at the receiver, while
the high reflective surface may be the opposite.
RS-Bpearl analyzes the received multiple return values and outputs the strongest, last or
simultaneous output of these two return values depending on the setting. If set to the
strongest return mode, only the strongest reflected return value is output. Similarly, if the
setting is the last return mode, only the last return value is output; if set to double return
mode, the strongest and last return information is output simultaneously.
Note: Only when the distance between two objects is greater than 1 meter, the LiDAR
could distinguish these two returns.

7.1.1The Strongest Return
When the LiDAR beam hits only one object, there is only the strongest return at this time.

7.1.2Strongest, Last and Dual Returns
When the laser pulse hit two objects at different distances, there will be two return wave,
then it will lead two situations:
(1) When the strongest return is not the last return, return the strongest and last return;
(2) When the strongest return is also the last return, return the strongest return and the
second strongest return.

7.1.3Return Mode Flag
The factory default setting for RS-Bpearl is the Strongest Return mode. If you need to
change the settings, please refer to Figure C-14 in Appendix C of this user manual. The
300th Byte in the DIFOP is the flag of the return mode, which corresponds to the following:
Table 8: Interchange between Return Mode and Flag Position.

Flag Position

Return Mode

00

Dual Returns

01

Strongest Return

02

Last Return
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7.2 Phase Lock
When using multiple RS-Bpearl sensors in proximity to one another, users may observe
interference between them due to one sensor picking up a reflection intended for another.
To minimize this interference, RS-Bpearl provides a phase-locking feature that enables
the user to control where the lase firings overlap.
The Phase Lock feature can be used to synchronize the relative rotational position of
multiple sensors based on the PPS signal and relative orientation. To operate correctly,
the PPS signal must be present and locked. Phase locking works by offsetting the rising
edge of the PPS signal.

Figure 9: Different phase lock angles 0°/135°/270°.

The red arrows in Figure 9 above indicate the firing direction of the sensor’s laser the
moment it receives the rising edge of the PPS signal.
In the Tools > RS-LiDAR Information of RSVIEW, we can set the Phase Lock angle from 0
to 359.
Only if the rotate speed is set to 600 rpm / 1200 rpm, the function of phase lock can be
worked.

18
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8. Point Cloud
8.1 Coordinating Mapping
In data packet including the measured azimuth and distance, in order to calculating the
point cloud, the coordinate in polar coordinate system should be transferred to the 3D
XYZ coordinate in Cartesian Coordinate System, as shown in figure 10. The function of
how to transfer the information is as shown below:
䋰䖧
th
䋰䖧
䋰 䖧 th
Here r is the reported distance,  is the vertical angle of the laser (which is fixed and is
given by the Laser ID), and  is the horizontal angle/azimuth reported at the beginning of
every other firing sequence. δ is the angle offset of the azimuth. x, y, z values are the
projection of the polar coordinates on the XYZ Cartesian Coordinate System.
The angle.csv file including  and δ can be exported from RSView. Please refer to
Appendix B.13 and B.14.

Figure 10: Coordinate system mapping between polar system and XYZ system.

Note 1: In the RS-Bpearl ROS package, the coordinate system must be transferred to the
ROS right-hand Coordinate system.
The ROS-X axis is co-axis with the Y-axis and with same direction as Figure 10.
The ROS-Y axis is co-axis with the X-axis but the positive direction is reverse as Figure
10.
The Z axis is same before and after transformation.
Note 2: The origin of the LiDAR coordinate is defined at the center of the LiDAR structure,
with 94.27 mm high to the bottom of the LiDAR.
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9. Definition of Vertical Angles
RS-Bpearl has a vertical field of view of 90° with a non-uniform distribution. The 32 laser
heads also called as 32 channels. The calibrated vertical angle and horizontal angle offset
can be found in DIFOP data.
Table 9: Correspondence between Channel No. and vertical Angle.

Channel
No.

Vertical Angle

Horizontal Offset Angle

1

89.5

0

2

81.0625

0

3

78.25

0

4

72.625

0

5

67

0

6

61.375

0

7

55.75

0

8

50.125

0

9

86.6875

0

10

83.875

0

11

75.4375

0

12

69.8125

0

13

64.1875

0

14

58.5625

0

15

52.9375

0

16

47.3125

0

17

44.5

0

18

38.875

0

19

33.25

0

20

27.625

0

21

22

0

22

16.375

0

23

10.75

0

24

5.125

0

25

41.6875

0

26

36.0625

0

27

30.4375

0

28

24.8125

0

29

19.1875

0

30

13.5625

0
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31

7.9375

0

32

2.3125

0

Every sequence of 32 laser firings consumes 55.5us.
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10.Reflectivity
The reflectivity is included in the data field of MSOP packet. Reflectivity is a scale to
evaluate the ability of the reflection of light from object. This value is highly related to the
material of measured object. Hence, the character can be used to distinguish the different
materials.
RS-Bpearl reports reflectivity values from 0 to 255 with 255 being the reported reflectivity
for an ideal reflector. Diffuse reflection reports values from 0 to 100, with the weakest
reflectivity reported from black objects and strongest reflectivity reported from white object.
Retro-reflector reports values from 101 to 255.

Figure 11: Calibration of Reflectivity.
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11.Troubleshooting
This section provides detail on how to troubleshoot your sensor.
Problem

Resolution

Interface BOX red LED doesn’t 
light or blink

Interface BOX red LED lights on
but green LED doesn’t light or 
blink

Rotor doesn’t spin



Reboot at the boot time


Unit spins but no data

Verify the power connection and polarity
Verify the power supply satisfy the requirement (at least 3A @ 12V)
Verify the connection between Interface BOX and LiDAR is solid.

Verify the Interface BOX LEDs is okay
Verify the connection between Interface BOX and LiDAR is solid.
Verify the power connection and polarity
Verify the power supply satisfy the requirement (at least 3A @ 12V)
Check if the LiDAR mounting plane is level or if the LiDAR bottom
fixing screws are too tight.
 Verify network wiring is functional.
 Verify receiving computer's network settings.
 Verify packet output using another application (e.g. Wireshark)
 Verify no security software is installed which may block Ethernet
broadcasts.
 Verify input voltage and current draw are in proper ranges

Check no firewall is active on receiving computer.
Check the receiving computer’s IP address is the same as LiDAR
destination IP address.
Can see data in Wireshark but
 Check the RSVIEW Data Port setting.
not RSVIEW
 Check the RSVIEW installation path and LiDAR configuration files path
both do not contain any Chinese characters.
 Check if the wireshark receive the MSOP packets.





Data dropouts







No data via router

Sensor point cloud data distortion 
GPS not synchronizing

This is nearly always an issue with the network and/or user computer.
Check the following:
Is there excessive traffic and/or collisions on network?
Are excessive broadcast packets from another service being
receivedby the sensor? This can slow the sensor down.
Is the computer fast enough to keep up with the packet flow coming
from the sensor?
Remove all network devices and test with a computer directly connected
to the sensor.
Check baud rate is 9600 and serial port set to 8N1 (8 bits, no parity, 1
stop bit).
Check the signal level is RS232 level
Check electrical continuity of PPS and serial wiring
Check incorrect construction of NMEA sentence
Check the GPS and Interface BOX are connected to the same GND
Check the GPS receive the valid data
Close the DHCP configuration
Check the configuration files is right

A blank region rotates in the
cloud data when using ROS
driver



This is the normal phenomenon as the ROS driver use fixed packets
quantity to divide display frame. The blank region data will output in the
next frame.

Point cloud data to be a radial



If the computer is windows 10 OS, then run the RSVIEW with windows
7 OS compatible mode.
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Appendix A Point Time Calculate
A.1 RS-Bpearl Calculation of time stamp in single mode
In each MSOP packet, there are 12 blocks, each block has one sequence for the whole 32
laser firings, so in a MSOP packet, there are 12 groups for the whole 32 laser firings. At
every firing moment, there are two laser firing together, all 32 lasers are fired and
recharged every 55.52 µs. The cycle time between firing is 1.28 µs. 32 firings cost time 32
x 1.28 µs = 40.96 µs. Besides, the charge/recharge time and wait time after emission must
be calculated. Therefore, this time interval = 2 * charge time + 2 * recharge time + wait
time = 2 * 4.00 us + 2 * 1.20 us + 4.16 us = 14.56 us.
Table A - 1: Time Offset for each Channel in single Return Mode.

In the firing sequence, Bpearl is first charged once, then the lasers fire one by one from
channel 1 to channel 8 and from channel 17 to channel 24 respectively. After that, Laser
emitters are charged once again, then lasers fire from Channel 9 to channel 16 and from
channel 25 to channel32 respectively.
Set the channel number data_index is 1~32, sequence_index is 1~12. Because the time
stamp is the time of the first data point in the packet, you need to calculate a time offset for
each data point and then add this offset to the time stamp.
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Time_offset is:
Formal for Calculation of Time_offset from Channel 1 to channel 8 and from channel 17 to
channel 24:
Time_offset = 55.52 * (sequence_index - 1) + 2.56 * mod((data_index – 1) , 16) + 1.28 *
floor((data_index-1) / 16)
Formal for Calculation of Time_offset from Channel 9 to channel 16 and from channel 25
to channel 32：
Time_offset = 55.52 * (sequence_index - 1) + 2.56 * mod((data_index – 1) , 16) + 1.28 *
floor((data_index-1) / 16) + 5.2
To calculate the exact point time, add the Time_Offset to the timestamp：
Exact_point _time = Timestamp + Time_offset
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A.2 RS-Bpearl Calculation of time stamp in dual mode
In dual mode, for each MSOP packet, there are 12 blocks. Each two block has one
sequence for the whole 32 laser firings, e.g. Block 1 and Block 2 are two captured return
signals after all 32 laser emitting once, Block 1 is the strongest return signal, block 2 is the
second strongest return signal.
Set the channel number data_index is 1~32, sequence_index is 1~12. Because the time
stamp is the time of the first data point in the packet, you need to calculate a time offset for
each data point and then add this offset to the time stamp.
Table A - 2. Time Offset for Each Channel in dual return mode.

26

RS-Bpearl User Manual
Time_offset is:
Formal for Calculation of Time_offset from Channel 1 to channel 8 and
from channel 17 to channel 24:
Time_offset = 55.52 * (floor ((sequence_index - 1) /2)) + 2.56 *
mod((data_index – 1) , 16)
+ 1.28 * floor((data_index-1) / 16)
Formal for Calculation of Time_offset from Channel 9 to channel 16 and
from channel 25 to channel 32：
Time_offset = 55.52 * (floor ((sequence_index - 1) /2)) + 2.56 *
mod((data_index – 1) , 16)
+ 1.28 * floor((data_index-1) / 16) + 5.2
To calculate the exact point time (Exact_point _time), add the Time_Offset
to the timestamp:
Exact_point _time = Timestamp + Time_offset
Note:
mod is an operator that divides two numbers and returns only the remainder.
floor is a function that returns an integer less than the argument or equal to it.
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Appendix B Information Registers
Here are definitions and more details on information registers as mentioned in chapter 5.

B.1 Motor(MOT_SPD)
Motor Speed (2 bytes in total)
Byte No.

byte1

Function

byte2

MOTOR_SPD

Register description:
(1) This register is used to set the rotation direction and rotation speed.
(2) The data storage format adopts big endian format.
(3) Supported rotation speed:
(byte1==0x04) && (byte2==0xB0) speed 1200rpm, clockwise rotation;
(byte1==0x02) && (byte2==0x58) speed 600rpm, clockwise rotation;
(byte1==0x01) &&(byte2==0x2C) speed 300rpm, clockwise rotation;
If set the value of rotation with other data, the rotation speed of the motor is 0.

B.2 Ethernet(ETH)
Ethernet (26 bytes in total)
Byte No.

byte1

byte2

Function
Byte No.

Function

byte4

byte5

byte6

LIDAR_IP
byte9

byte10

Function
Byte No.

byte3

byte18
port2

byte8

DEST_PC_IP

byte11

byte12

byte13

byte14

MAC_ADDR
byte17

byte7

byte19

byte20
port3

byte16
port1

byte21

byte22
port4

Register description:
(1) LIDAR_IP is the LiDAR source IP address, it takes 4 bytes.
(2) DEST_PC_IP is the destination PC IP address, it takes 4 bytes.
(3) MAC_ADDR is the LiDAR MAC Address.
(4) port1~port6 signals the number of ports. Port1 and port2 are the
MSOP packet ports, we suggested to set them to the same number.
Port3 and port4 are the DIFOP packet ports, we suggested to set
them to the same number.
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B.3 FOV Setting (FOV SET)
FOV Setting(Total 4bytes)
Byte No.
Function

byte1

byte2

byte3

FOV_START

byte4

FOV_END

Register Description:
Set the horizontal angle range of the device for outputting valid data, FOV_START and
FOV_END adjustment range 0~36000, corresponding angle 0~360°, the data storage
format adopts big endian format.
For example:
byte1=0x5d, byte2=0xc0, byte3=0x1f, byte4=0x40,
so:
FOV_START = 93*256+192=24000 FOV_END = 31*256+64=8000
Indicates that the valid data output has a horizontal angle ranging from 240.00°to 80.00°.
Note: In all above calculation, bytes have been transformed to decimal.

B.4 Motor Phase Offset (MOT_PHASE)
Motor Phase Offset(2bytes in total)
Byte No.
Function

byte1

byte2

MOT_PHASE

Register description: It can be used to adjust the phase offset of the motor with the PPS
together. The value can be set from 0 to 360. The data storage format adopts big endian
format.
For example:
the byte1=1, byte2=14, so the motor phase should be 1*256+14 = 270.
Note: In all above calculation, bytes have been transformed to decimal.

B.5 Top Board Firmware (TOP_FRM)
Top Board Firmware(5bytes in total)
Byte No.
Function

byte1

byte2

Byte3

Byte4

Byte5

TOP_FRM

Register description：
If our top board firmware revision is T6R23V6_T6_A, then TOP_FRM will output 06 23 06
06 A0,0x06230606A0.
In the output, the A represents release version Application, while the F represents factory
version Factory.
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B.6 Bottom Board Firmware (BOT_FRM)
Bottom Board Firmware(5bytes in total)
Byte No.

byte1

byte2

Function

Byte3

Byte4

Byte5

BOT_FRM

Register description：
If our top board firmware revision is B7R14V4_T1_F, then BOT_FRM will output 06 23 06
06 F0. In the output, the A represent release version Application, while the F represent
factory version Factory.

B.7 Serial Number(SN)
Serial Number(6 bytes in total)
Byte No.

byte1

byte2

byte3

Function

byte4

byte5

byte6

SN

The Serial Number of each device adopts the same format as the MAC_Address, namely,
a 6-byte hexadecimal number.

B.8 Software Version(SOFTWARE_VER)
Software Version(2 bytes in total)
Byte No.

byte1

Function

byte2

SOFTWARE_VER

B.9 UTC Time(UTC_TIME)
UTC Time (8 bytes in total)
Byte No.

byte1

byte2

byte3

byte4

byte5

byte6

Function

year

month

day

hour

min

sec

Byte No.

byte9

byte10

bit3

bit2

Function

byte7

byte8
ms

μs

Register description:
(1) year
set_year
Byte No.

bit7

Function

bit6

bit5

bit4

bit1

bit0

set_year[7:0]：data 0~255 corresponds year 2000 to year 2255.

(2) month

set_month
Byte No.

bit7

bit6

bit5

bit4

Function

reserve

reserve

reserve

reserve
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bit1

bit0

set_month[3:0]：1~12 month
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(3) day

set_day

Byte No.

bit7

bit6

bit5

Function

reserve

reserve

reserve

(4) hour

bit4

bit3

bit2

bit1

bit0

set_day[4:0]：1~31 day
set_hour

Byte No.

bit7

bit6

bit5

Function

reserve

reserve

reserve

(5) min

bit4

bit3

bit2

bit1

bit0

set_hour[4:0]：0~23 hour
set_min

Byte No.

bit7

bit6

Function

reserve

reserve

(6) sec

bit5

bit4

bit3

bit2

bit1

bit0

bit1

bit0

bit9

bit8

set_min[5:0]：0~59 min
set_sec

Byte No.

bit7

bit6

Function

reserve

reserve

(7) ms

bit5

bit4

bit3

bit2

set_sec[5:0]：0~59 sec
set_ms

Byte No.

bit15

bit14

bit13

bit12

bit11

bit10

Function

reserve

reserve

reserve

reserve

reserve

reserve

Byte No.

bit7

bit6

bit5

bit4

bit3

bit2

bit1

bit0

bit9

bit8

Function
(8) μs

ms[9:8]

set_ms[7:0]

Note：set_ms[9:0] value：0~999
reg name：set_us

Byte No.

bit15

bit14

bit13

bit12

bit11

bit10

Function

reserve

reserve

reserve

reserve

reserve

reserve

Byte No.

bit7

bit6

bit5

bit4

bit3

bit2

bit1

byte6

byte7

Function

us[9:8]
bit0

set_us[7:0]

Note：set_us[9:0] value：0~999

B.10

STATUS
Status (18bytes in total)

Byte No.

byte1

Function

byte2

byte3

byte4

Idat1_reg

Byte No.

byte9

byte10

Function

Vdat_12V_M_reg

Byte No.

17byte

Function

Vdat_1V2_reg

byte5
Idat2_reg

byte11

byte12

Vdat_5V_reg

byte13

byte8

Vdat_12V_reg
byte14

Vdat_3V3_reg

byte15

byte16

Vdat_2V5_reg

18byte

Register description:
(1) Idat1 is sensor power supply current, Idat2 is top board power supply current.
We use Idat to represent Idat1 or Idat2. Idat_reg contains 3 bytes to be
Idat_reg[23:0]. Idat_reg[23] is symbol flag, while Idat_reg[22:0] is current value.
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dat䋰

The LSB for Idat is 1μA, the formula is as below:
݀ ܽ 䖧 ̴ ݃ ݁ݎݎ
݀ ܽ 䖧 ̴ ݎ憌݃ 䋰
݀ ܽ 䖧 ̴ ݃ ݁ݎݎ
dat䋰
݀ ܽ 䖧 ̴ ݃ ݁ݎݎ
݀ ܽ 䖧 ̴ ݎ憌݃ 䋰
݀ ܽ 䖧 ̴ ݃ ݁ݎݎ

݀ ܽ 䖧 ̴ ݎ憌݃ 䋰
݀ ܽ 䖧 ̴ ݎ憌݃ 䋰

For example, if byte1 = 8C, byte2 = D5 and byte3 = 00, then the current value is:

Idat = -Idat_reg[22:0] = -0x0CD500 uA = -840960uA≈-841mA
(2) There are six different voltages, each voltage register has 2 bytes to be
Vdat_reg[15:0]. Vdat_reg[15:12] is invalid, while Vdat[11:0] represent the
voltage value. The six different voltage formula is as below:

The unit above is volt (V).

B.11

Fault Diagnosis
Fault Diagnosis (40bytes in total)

Byte No.
Function

byte1

byte2

Byte No.
Function

byte9
byte10
internal debug

Byte No.
Function

byte17
byte18
temperature1

byte19
byte20
temperature2

Byte No.
Function

byte25
byte26
temperature5

byte27

byte28

byte29
byte30
internal debug

byte31

byte32
r_rpm1

Byte No.
Function

byte33
r_rpm2

byte35

byte36

byte37
byte38
internal debug

byte39

byte40

byte34

byte3

byte4
byte5
internal debug

byte6

byte7

byte8

byte11
cksum_st

byte12
byte13
manc_err1

byte14
byte15
manc_err2

byte16
gps_st

byte21
byte22
temperature3

byte23
byte24
temperature4

Register description:
(1) chksum_st represents the temperature compensation status. If chksum_st = 0x00, the
temperature compensation is working. If chksum_st = 0x01, the temperature
compensation is, the temperature compensation is abnormal.
(2) manc_err1 and manc_err2 are used to calculate the bit error rate of the data
communication. manc_err1 represents 1bit error, while manc_err2 represents 2bit error.
The error rate formula is as below:
h 䖧䖧
䖧䋰
h 䖧䖧  ݎൌൌ憌 ܽ
ܿ
h 䖧䖧 ݎ䖧 䋰
h 䖧䖧 ݎݎൌൌ憌 ܽ
ܿ
When the manc_err1_per and manc_err1_per are both zero, the system data
communication is normal.
(3) Temperature1 and temperature2 represent the bottom board temperature, while
temperature3 and temperature4 represent the top board temperature. Each temperature
register contains 2 bytes to be temperature_reg[15:0]. temperature_reg[2:0] is invalid.
temperature_reg[15:3] is temperature value, while temperature_reg[15] is symbol flag.
The temperature formula is as below:

32

RS-Bpearl User Manual
Temperature5 represents bottom board temperature. The temperature register contains 2
bytes
to
be
temperature_reg[15:0].
temperature_reg[15:12]
is
invalid.
temperature_reg[11:0] is temperature value, while temperature_reg[15] is symbol flag.

(4) Byte16 represents the GPS input status register gps_st, this register uses 3 bits to
describe the validation for PPS, GPRMC, and timestamp. The details are shown below:
GPS input status register GPS_ST
BIT

Function

bit0

PPS_LOCK

bit1

GPRMC flag:
GPRMC_LOCK

bit2

UTC_LOCK

Value

Status

0

PPS is invalid

1

PPS is valid

0
1

GPRMC is invalid
GPRMC is valid
LiDAR internal timestamp is not synchronizing the
UTC.
LiDAR internal timestamp is synchronizing the
UTC.

0
1

bit3~bit7

Reserved
x
N/A
(1) The real-time rotation speed of the motor is composed of two bytes, byte32 and
byte33. The calculation formula is as follows:
Motor real-time rotation speed = (256 * r_rpm1 + r_rpm2)÷6
(2) The reset is used for internal debug, they are not opened.

B.12

ASCII code in GPRMC Packet

GPRMC register reserve 86 bytes, it can store the whole GPRMC message from GPS
module in to the register in ASCII code.

B.13

Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function

Corrected Vertical Angle (COR_VERT_ANG)
Corrected Vertical Angle（96bytes in total）
byte1
byte2
byte3
byte4
byte5
byte6
Channel 1_COR_VERT_ANG
Channel 2_COR_VERT_ANG
byte10
byte11
byte12
byte13
byte14
byte15
Channel 4_COR_VERT_ANG
Channel 5_COR_VERT_ANG
byte19
byte20
byte21
byte22
byte23
byte24
Channel 7_COR_VERT_ANG
Channel 8_COR_VERT_ANG
byte28
byte29
byte30
byte31
byte32
byte33
Channel 10_COR_VERT_ANG
Channel 11_COR_VERT_ANG
byte37
byte38
byte39
byte40
byte41
byte42
Channel 13_COR_VERT_ANG
Channel 14_COR_VERT_ANG
byte46
byte47
byte48
byte49
byte50
byte51
Channel 16_COR_VERT_ANG
Channel 17_COR_VERT_ANG
byte55
byte56
byte57
byte58
byte59
byte60
Channel 19_COR_VERT_ANG
Channel 20_COR_VERT_ANG
byte64
byte65
byte66
byte67
byte68
byte69
Channel 22_COR_VERT_ANG
Channel 23_COR_VERT_ANG
byte73
byte74
byte75
byte76
byte77
byte78
Channel 25_COR_VERT_ANG
Channel 26_COR_VERT_ANG
byte82
byte83
byte84
byte85
byte86
byte87
Channel 28_COR_VERT_ANG
Channel 29_COR_VERT_ANG
byte91
byte92
byte93
byte94
byte95
byte96
Channel 31_COR_VERT_ANG
Channel 32_COR_VERT_ANG
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byte7
byte8
byte9
Channel 3_COR_VERT_ANG
byte16 byte17
byte18
Channel 6_COR_VERT_ANG
byte25 byte26
byte27
Channel 9_COR_VERT_ANG
byte34 byte35
byte36
Channel 12_COR_VERT_ANG
byte43 byte44
byte45
Channel 15_COR_VERT_ANG
byte52 byte53
byte54
Channel 18_COR_VERT_ANG
byte61 byte62
byte63
Channel 21_COR_VERT_ANG
byte70 byte71
byte72
Channel 24_COR_VERT_ANG
byte79 byte80
byte81
Channel 27_COR_VERT_ANG
byte88 byte89
byte90
Channel 30_COR_VERT_ANG
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Register description:
(1) The angle value is signed integer, vertical angle for each channel is consist of 3
bytes, while the first byte represents the sign, the second byte and the third byte
represent the value for the angle, storage mode is Big-endian.
(2) The first byte 0x00 represents positive while 0x01 represents negative.
(3) LSB=0.01º.
For example the register for vertical angle of Channel 1is as below: byte1=0x00,
byte2=0x22 convert to decimal is 34, byte3=0XF6 convert to decimal is 246, so the
vertical angle of Channel 1 is：
(34*256+ 246) *0.01º = 89.50º

B.14

Corrected Horizontal Offset Angle (COR_HOR_ANG)

Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function
Byte No.

Function

Corrected horizontal Angle（96bytes in total）
byte1
byte2
byte3
byte4
byte5
byte6
Channel 1_COR_HOR_ANG
Channel 2_COR_HOR_ANG
byte10
byte11
byte12
byte13
byte14
byte15
Channel 4_COR_HOR_ANG
Channel 5_COR_HOR_ANG
byte19
byte20
byte21
byte22
byte23
byte24
Channel 7_COR_HOR_ANG
Channel 8_COR_HOR_ANG
byte28
byte29
byte30
byte31
byte32
byte33
Channel 10_COR_HOR_ANG
Channel 11_COR_HOR_ANG
byte37
byte38
byte39
byte40
byte41
byte42
Channel 13_COR_HOR_ANG
Channel 14_COR_HOR_ANG
byte46
byte47
byte48
byte49
byte50
byte51
Channel 16_COR_HOR_ANG
Channel 17_COR_HOR_ANG
byte55
byte56
byte57
byte58
byte59
byte60
Channel 19_COR_HOR_ANG
Channel 20_COR_HOR_ANG
byte64
byte65
byte66
byte67
byte68
byte69
Channel 22_COR_HOR_ANG
Channel 23_COR_HOR_ANG
byte73
byte74
byte75
byte76
byte77
byte78
Channel 25_COR_HOR_ANG
Channel 26_COR_HOR_ANG
byte82
byte83
byte84
byte85
byte86
byte87
Channel 28_COR_HOR_ANG
Channel 29_COR_HOR_ANG
byte91
byte92
byte93
byte94
byte95
byte96
Channel 31_COR_HOR_ANG
Channel 32_COR_HOR_ANG

byte7
byte8
byte9
Channel 3_COR_HOR_ANG
byte16
byte17
byte18
Channel 6_COR_HOR_ANG
byte25
byte26
byte27
Channel 9_COR_HOR_ANG
byte34
byte35
byte36
Channel 12_COR_HOR_ANG
byte43
byte44
byte45
Channel 15_COR_HOR_ANG
byte52
byte53
byte54
Channel 18_COR_HOR_ANG
byte61
byte62
byte63
Channel 21_COR_HOR_ANG
byte70
byte71
byte72
Channel 24_COR_HOR_ANG
byte79
byte80
byte81
Channel 27_COR_HOR_ANG
byte88
byte89
byte90
Channel 30_COR_HOR_ANG

Register description ：
(1) The angle value is signed integer, vertical angle for each channel is consist of 3
bytes, while the first byte represents the sign, the second byte and the third byte
represent the value for the angle.
(2) The first byte 0x00 represents positive while 0x01 represents negative.
(3) LSB=0.01º;
For example the register for vertical angle of Channel 10 is as below: byte1=0x01,
byte2=0x00 convert to decimal is 0, byte3=0x0A convert to decimal is 10, so the
vertical angle of Channel 10 is：
-(0*256+ 10) *0.01=-0.1º
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Appendix C RSView
In this appendix, the record, visualization, save and redisplay of the data from RS-Bpearl
will be interpreted with using RSView. The original sensor data can be also captured and
examined by using other free tools, such as Wireshark or TCP-Dump. But visualization of
the 3D data through using RSView is easy to realize. RS-Bpearl is used with RSView
vision 3.1.5. or above

C.1 Software Features
RSView can provide real-time visualization of 3D coordinate data from RS-Bpearl.
RSView can also review the pre-recorded data stored in “pcap” (Packet Capture) files, but
RSView still doesn’t support directly importing “.pcapng” files.
RSView displays directly the point cloud that is exchanged from the measured distance
from RS-Bpearl. It supports changing the display mode of point cloud as user wishes,
according to Reflectivity, timestamp, distance, azimuth, and laser channel. The data can
be exported as XYZ coordinate data in CSV format or LAS format. RSView does not
support generating point cloud files in XYZ, or PLY formats.
Function and features of RSView are shown as follow:
 Online visualization of sensor data over Ethernet
 Record of real-time data into pcap files
 Review of the collected point cloud from pcap files
 Different visualization mode based on distance, timestamp, azimuth, laser ID,
etc.
 Tabular inspection of point cloud data
 Exporting the point cloud data into CSV format
 Tool for measuring distance from visualized cloud point
 Simultaneously Display of multiple continuous frames (Trailing frames)
 Display or hide subsets of lasers
 Crop tool to show partial point cloud

C.2 Installation of RSView
Installation packet of RSView is suited for Windows 64-bit system and it has no need for
other dependent software packets.
The latest version of executable installation packet can be found from RoboSense website
(http://www.robosense.ai/resource). Launch the installation packet and follow the
instructions to complete the installation. The installation path should not contain any
Chinese characters.

C.3 Network Setup
As mentioned in the chapter 5, the default IP address of the computer should be set as
192.168.1.102, sub-net mask should be 255.255.255.0. You should make sure RSView
doesn’t be blocked by firewall in PC.

C.4 Visualization of point cloud
1. Connect the RS-Bpearl to PC over Ethernet cables and power supply.
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2. Right Click to start the RSView application with Run as administrator.
3. Click on the “File”-> Open -> Sensor Stream (Fig. C-1).

Figure C - 1: Open sensor stream in RSView.

4. After finishing above 3 steps, the dialogue box “Sensor Configuration” shows up. In this
dialogue box, the default configuration folder of RS-Bpearl calibration is already contained and
the folder is already chosen. In “Type of LiDAR”, the option RSBpearl should be chosen, in
“Intensity”, Mode3 should be chosen. Finally, click “OK” (as shown in Fig. C-2).

Figure C - 2: RSView Select Sensor Correction File.

RSView begins displaying the colored point cloud from capturing the sensor data stream from
LiDAR (as shown in Fig. C-3). The stream can be paused by pressing the “Play/Pause”
button.

Figure C - 3: RSView Sensor Stream Display.
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C.5 Save Streaming Sensor Data into PCAP File
1. Click the “Record” button while real-time display (Fig. C-4).

Figure C - 4: RSView Record Button.

2. In the dialogue box Choose Output File, the save path and file name of pcap file can
be set up. (Fig. C-5). After clicking “save” button, RSView begins writing data into pcap file.
(Note: RS-Bpearl will generate enormous measuring data. So, it is best to use a fast, local
HDD or SSD, not to use a slow subsystem such as USB storage device or network drive.)

Figure C - 5: RSView Record Saving Dialog.

3. Click “Record” Button will finish record and save the all recorded data into this pcap
file.

C.6 Replay Recorded Sensor Data from PCAP Files
In order to replaying (or examining) a pcap file, please import it into RSView. Then press
“Play/Pause” button to let it play or scrub the time slider to a certain time point as user
wishes. When only a part of 3D point cloud is concerned, it can be selected out by
mouse. Then point cloud data of this part can be shown in table. Save path of pcap file
can’t contain Chinese characters.
1. Click File -> Open then select Capture File.

Figure C - 6: RSView Open Capture File.

2. In dialogue box “Open File”, please import a recorded pcap file then click “open (O)”
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button.

Figure C - 7: Select the PCAP File.

3. In dialogue box Sensor Configuration, please add and select the right configuration
file of RS-Bpearl, then click OK.
4. Clicking “Play/Pause” button can make 3D point cloud stream play and pause. Using
the Scrub tool can select out the interesting frame. (Fig. C-8)

Figure C - 8: RSView Play Button and Scrub slide tool.

5. In order to inspecting partial relevant point cloud data from a closer aspect, please

scrub to an interesting frame and click the Spreadsheet button (Fig. C-9). A data table will
be displayed on the right side. It contains all displayed data points in the frame.

Figure C - 9: RSView Spreadsheet tool.

6. The dimension and the sort of data in this table are adjustable. That can make the

display more obvious. (Fig. C -10)

Figure C - 10: RSView Data Point Table.
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7. Click “Show only selected elements” in spreadsheet can acquire correspondingdata,
certainly there is no data shown in table, if no one point is selected. (Fig.C -11)

Figure C - 11: RSView Show Only Selected Elements.

8. By using “Select All Points”Tool, the arbitrary point can be selected. (as shown in Fig.
C -12)

Figure C - 12: RSView Select All Points.

In the 3D rendered data pane using mouse to draw a rectangle around a small number of
points. The values of them can be immediately shown in the table (Fig. C-13).

Figure C - 13: RSView Selected Points.

9. Any selected point can be saved by doing File->Save As->Select Frames.

C.7 RS-Bpearl Factory Firmware Parameters Setting
RSView supplies a tool which integrates UCWP Protocol. It can be used to modify Rotate
Speed, Network, Time, FOV and return mode in RS-Bpearl factory firmware.
Before setting the firmware parameters, please ensure the connectivity of the RS-Bpearl
and Display of real-time point cloud. Then Click Tools > RS-LiDAR Information, next, in
RS-LiDAR Information dialogue, click “Get” button, the current firmware parameters
setting will be shown in this dialogue.
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Figure C – 14: RS-LiDAR Information.

After modifying the values of parameters, click “Set LiDAR”, the Parameter will be set to
what user needs (the red marks in Figure C-15 are only an example, it shows a possibility
for parameter change). Then wait 10 seconds, restart RS-Bpearl, wait for device
connected, open the RSView to check, whether parameters have been changed.

Figure C-15: Set LiDAR information.
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Figure C – 16: Set LiDAR information successful.

Note 1: during the process of parameter setting, please not cut off the power supply.
Otherwise, the internal parameters in LiDAR will be incorrectly saved.
Note 2: if the MSOP Port or the DIFOP Port is modified, please set the Data Port in
RSView first according to following section C.8 before reconnecting device.

C.8 Setting RSView Data Port
The MSOP Port by default is 6699, and the DIFOP Port is 7788. If one of the two
parameters or both of them has been changed (just like the description in section C-7), the
new Data Port in RSView must be set and refreshed. Otherwise, the data won’t be
displayed. If the MSOP Port and DIFOP Port in RS-Bpearl are unknown or forgotten, user
can utilize the software Wireshark to capture the data packet from Dst Port.
Click Tools > Data Port, type the MSOP Port and the DIFOP Port changed, then click Set
Data Port.

Figure C-17: Set Data Port.

C.9 Firmware Update Online
Please ensure the connectivity of LiDAR, and point cloud can be displayed and get the
firmware information according to section C.8.
Click Tools > Online Update, as shown in Figure C-18, top board update and bottom board
update could be selected.

Figure C-18: Online Update.
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For example, click Bottom Board Update, then choose the proper firmware file with suffix
“.rpd”, then click open, start Bottom Board Update. The update process will take a while,
after update “Online Update Successful” will be shown in a message box.
Note: Config Updata is not available.

Figure C-19: select update firmware.

Figure C-20: Online Update successfully.

C.10 Troubleshooting by Fault Diagnosis
Firstly, need to check connectivity of RS-Bpearl, point cloud can be displayed normally
and the Firmware information (as shown in section C.8) can be got.
Click Tools > Fault Diagnosis, Fault diagnosis window will be shown. Click “Start”
button, the conformance of RS-Bpearl can be real-time monitored, the parameter
including current, voltage, temperature, Uart Baund Error and so on.
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Figure C-21: Fault Diagnosis Dialogue.
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Appendix D RS-Bpearl ROS Package
This appendix describes how to use Ubuntu + ROS to acquiring and visualizing the
measuring data from RS-Bpearl.

D.1 Software Installation
1. Download and Install Ubuntu 16.04 OS.
2. Please refer the link (http://wiki.ros.org/kinetic/Installation) to install the ROS Kinetic.
3. Download and install libpcap-dev.

D.2 Compile RS-Bpearl ROS Package
1. Create a workspace for ROS:
cd ~
mkdir -p catkin_ws/src

2. Copy the corresponding ros_rslidar_package into the ROS workspace under the path:
~/catkin_ws/src. The latest ros_rslidar driver can be downloaded from
https://github.com/RoboSense-LiDAR/ros_rslidar or contact Robosense support.
3. Build：
cd ~/catkin_ws
catkin_make

4. Place the configuration file of corresponding LiDAR into PC:
5. At present, configuration files have been written in LiDAR. If not, use the configuration
files by default in ROS-Driver. Meanwhile, update the parameter in launch file. This path of
launch file can be customized.
6. For example: rslidar_pointcloud/data/rs_Bpearl
7. Note: If user needs to modify the code, relevant code files could not be read.

D.3 Configure PC IP address
For the default RS-Bpearl firmware, static IP address of PC is configured to
“192.168.1.102”, submask: “255.255.255.0”, gateway doesn’t need to configure.
After configuring the static IP, it can be examined in CMD with code ifconfig.

D.4 Display of the real-time data
1. Connect the RS-Bpearl to PC via twister pair wire with RJ45 connector, power on it,
then wait for PC cognizing LiDAR.
2. An example launch file has been provided under path: rslidar_pointcloud/launch, in
order to starting the node that can be run to visualize the real-time point cloud data. Open
a terminal with a location as shown as below:
cd ~/catkin_ws
source devel/setup.bash
roslaunch rslidar_pointcloud rs_Bpearl.launch
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3. Open a new terminal:
rviz

Set the Fixed Frame to "rslidar", add a Pointcloud2 type and set the
topic to "rslidar_points".

Figure D - 1. Display point cloud Data in Rviz.

D.5 Offline Display the recorded PCAP File
The ros_rslidar ROS package can be also use to display the recorded. Pcap offline data.
1. Modify the “rs_Bpearl.launch” file like below (please pay attention to the red code line):
<launch>

<arg name="model" default="RS-BPearl" />
<arg name="device_ip" default="192.168.1.200" />
<arg name="msop_port" default="6699" />
<arg name="difop_port" default="7788" />
<arg name="lidar_param_path" default="$(find rslidar_pointcloud)/data/rs_lidar_Bpearl/"/>
<node

name="rslidar_node" pkg="rslidar_driver" type="rslidar_node" output="screen" >

<param name="model" value="$(arg model)"/>
<param name="device_ip" value="$(arg device_ip)" />
<param name="msop_port" value="$(arg msop_port)" />
<param name="difop_port" value="$(arg difop_port)"/>
<param name="pcap" value="指向.pcap 的绝对路径"/>
</node>
<node

name="cloud_node" pkg="rslidar_pointcloud" type="cloud_node" output="screen" >

<param name="model" value="$(arg model)"/>
<param name="curves_path" value="$(arg lidar_param_path)/curves.csv" />
<param name="angle_path" value="$(arg lidar_param_path)/angle.csv" />
<param name="channel_path" value="$(arg lidar_param_path)/ChannelNum.csv" />
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</node>
<node name="rviz" pkg="rviz" type="rviz"

args="-d $(find rslidar_pointcloud)/rviz_cfg/rslidar.rviz" />

</launch>

2. Open a terminal, run the node:
cd ~/catkin_ws

source devel/setup.bash
roslaunch rslidar_pointcloud rs_lidar_Bpearl.launch

3. This step is same as step 3 in section C.4.
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Appendix E Dimension

Figure E - 1. Dimension Drawing of RS-LiDAR-Bpearl.
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Appendix F Suggestion of Mechanical LiDAR Mount
Please make sure the surface of platform used for mounting LiDAR is smooth as possible.
Please make sure the locating pin on the mount surface do exceed 4mm high. The
material of the mount platform is suggested to be aluminum alloy in order to thermolysis.
When the LiDAR is installed, if there is a mounting contact surface on the upper and
bottom sides of the LiDAR, make sure that the spacing between the mounting surfaces is
greater than the height of the LiDAR to avoid squeezing the LiDAR.
When the LiDAR cable is routed in the mount device, please keep the cable a little slack,
not too tense.
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Appendix G Seek MSOP and DIFOP Port Number
According to the description of chapter 5, MSOP and DISOP are the two protocols can be
sent out by RS-Bpearl. Their content could be parsed from excepted port by wireshark
that is a network protocol analyzer. The port information can be used to set up the Data
Port in RSView.
The steps of wireshark usage to set up the right port number for RSView:
Connect LiDAR to PC and power supply to it. Open wireshark software, choose the
corresponding Ethernet port, start to capture packet from LiDAR sending. Type filter
condition “data.data[0:1]==55” into the display filter (Hot key: Ctrl + /). Then the MSOP
packet can be filtered out. The MSOP port number can be checked in info column, as
shown in Figure G-1.
For DIFOP port number checking, all of the steps are same except the step of typing filter
condition with “data.data[0:1]==a5” , as shown in Figure G-2.

Figure G - 1. Wireshark Filtering Out MSOP Port Number.

Figure G - 2. Wireshark Filtering Out DIFOP Port Number.
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Appendix H Clean of LiDAR
H.1 Attention
Before cleaning the RS-LiDAR, please read through this entire Appendix F. Otherwise,
improper handling can permanently damage it.
When the sensor is used in a harsh environment, it is necessary to clean it in time to keep
its performance.

H.2 Required Materials
(1)
(2)
(3)
(4)
(5)

Clean microfiber cloths
Mild, liquid dish-washing soap
Spray bottle within warm, clean water
Solution of Isopropyl alcohol
Clean gloves

H.3 Clean Method
If the sensor is just covered by dust, use a clean microfiber cloth with a little isopropyl
alcohol to clean the sensor directly, then dry with another clean microfiber cloth.
If the sensor is caked with mud or bugs, use a spray bottle with clean, warm water to
loosen any debris from it. Do not wipe dirt directly off the sensor. Doing so may abrade the
surface. Then use warm, mildly-soapy water and gently wipe the sensor with a clean
microfiber cloth. Wipe the ring lens gently along the curve of the sensor, not top-to-bottom.
To finish, spray the sensor with clean water to rinse off any remaining soap (if necessary,
use isopropyl alcohol and a clean microfiber cloth to clean any remaining dirt from the
sensor), then dry with another clean microfiber cloth.
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